
Welcome to the QuickBooks Software Development Kit (SDK) Version 7.0.

IMPORTANT

This software is designed for use with US editions of 
QuickBooks 2008 and QuickBooks Merchant Service. In 
addition, selected features of this software can be used with 
US editions of QuickBooks 2002, 2003, 2004, 2005, 
2006,2007, QuickBooks Online Edition, and certain Canadian 
and UK editions of QuickBooks (2003 and later). However, 
you cannot currently install and use QuickBooks for different 
countries on the same machine.

Release Note History
In order to see what changed, especially which field values, enums, and QBFC-related 
items changed from release to release, you need to take a look at the Release Notes for the 
periods you are interested in. Release Notes from SDK 3.0 to the current release can be 
found at the IDN website.
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A Note About Credit Card Numbers in QB 2008 and Later
Due to requirements of the payment card industry, QuickBooks 2008 and later will mask all 
credit card data returned from SDK requests. All responses that return credit card 
information will return only masked numbers, even in a customer query, when invoked 
against QuickBooks 2008 and later.

What’s New in SDK 7.0?
In this version of the QuickBooks SDK, our goal was to make it easier for you to develop 
applications for QuickBooks by providing new and enhanced tools, greater access to 
QuickBooks features, and improved performance for your customers in the most widely 
used queries. 

Overview

Here is what’s new:

• Our totally revamped Onscreen Reference (OSR) provides one central, unified access 
point where you can find out everything you need to know for all SDKs: 
> All current SDKs on one page
> Maps Quickbooks UI to SDK request fields
> Links to related topics (doc and Alpha Geek) from each request
> C# and VB.Net sample code

• Our new Visual Studio Application Template (for C#) significantly decreases coding 
time and learning curve through:
> Code generation resulting from responses to a wizard
> Built-in session management for each supported QuickBooks connection type
> A self-contained COM event handler requiring that the developer only implement 

application logic within your project templateís generated event handler stub.
• QuickBooks Web Connector 2.0 has been updated to include an asynchronous 

pluggable protocol handler which allows web-based applications to directly interact 
with the web connector from Javascript. (With Version 2.0 the protocol handler works 
only with Internet explorer.) Other additions and enhancements have also been made: 
for more information see “What’s New in QBWC Web Connector 2.0.”
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• After a brief hiatus, the Remote Data Sharing feature has been updated and re-included 
with the SDK. The new RDS is completely rewritten in .NET and is expected to be 
much more robust than the previous version.

• More QuickBooks features are available through the SDK:
> Accounts now support tax lines
> BuildAssemblyAdd now allows you to create pending builds
> CheckAdd now supports linking to certain transactions, which makes it much 

easier to issue direct refunds. (In the 7.0 qbXML spec, but to be implemented in the 
R3 patch to QB2008.) Likewise, CheckQuery has the IncludeLinkedTxns boolean 
added to support this new functionality but that won’t be available til R3 either.

> Credit card transaction (requires QBMS) enhancements
-CompanyQuery returns subscribed-to services (QBMS, payroll, etc) 
-Multiple credit card transactions supported in one SalesReceipt
-Multiple credit card transactions supported in one CreditMemo
-PaymentMethodAdd allows setting of payment type, using supplied enum
-ReceivePayment supports Auths and subsequent Captures

> CustomerQuery up to 5 times faster
> DepositMod
> Estimates add Ship-to and price level fields
> ListMerge, for merging accounts, customers, vendors 
> Item enhancements:

-manufacturers part number
-modify income and expense accounts referenced by the item

> List objects (customers, vendors, items, etc) get their TimeModified updated 
whenever their balance, on-hand quantity, linked transaction changes

> Queries provide better support for TimeModified filters
> Unattended mode performance improved through faster QB Start-up
> Unit of measure support, consisting of UnitOfMeasureSetAdd/Query and also unit 

of measure support in Items and transaction lines)
> VendorQuery up to twice as fast
> Workers compensation codes (Add, Mod, Query)

The New OnScreen Reference (OSR)

In QB SDK 6.0, an early version of an AJAX-based OSR was made available. The SDK 
7.0 OSR enhances this version with more functionality and content. 

Automatic Filtering for Specified QuickBooks and qbXML-Level

One of the key improvements in the new OSR is automatic filtering, which can save you 
from making mistakes. In the new OSR, you select the version(s) of QuickBooks that you 
are interested in, the qbXML spec level, and the OSR automatically displays only the 
requests and request fields that apply to what you have specified.
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All SDKs from IDN Available in Left Navigation Pane

Another key benefit is the inclusion of OSRs for all SDKs available for IDN in the left 
navigation pane. Those are listed even if not installed and you can click on the links to 
download those SDKs when you are ready for them.

New qbXML and C# Samples for each Request

Each qbXML request now has sample qbXML script showing how it is built. The QBFC 
version of these requests now have C# as well as VB.Net samples.

Each Request Has Topic-Level Links to Programmer’s Guide

Prior to the SDK 7.0 release, after reading the brief description in the OSR, you had to 
search through the QBSDK Programmer’s Guide to find more detailed description within 
the chapters in that guide. Starting with SDK 7.0, each request links directly to the related 
material in the Guide, to save you time and possibly errors.

Links to AlphaGeek and Other Information

Along with Programmers’ Guide links, some of the requests have links to other articles, 
such as AlphaGeek articles.

Error-Code Lookup

A handy improvement in the new OSR is the error lookup control on the main page. Just 
supply the QB error code, either in decimal or hex, depending on what you have, and the 
explanation is displayed for you.

The New Visual Studio C# QBSDK Project Template

Because the process of connecting to QuickBooks and sending requests is the same from 
application to application, we built a Visual Studio C# Application Template. A wizard 
guides you through a series of questions and then auto-generates code for you as a function 
of your responses. All of the connection types (QB desktop, QBOE, etc) are supported. 
Your task is simplified as you only need to add the desired QuickBooks requests using 
QBFC.

We also implemented error trapping and logging for you in the template project, to aid in 
debugging your customerís problems. Three levels of logging are available: none, critical 
errors only, all errors, and verbose.

Finally, we added an entire COM event handler for you, if it is required. The wizard asks 
you a series of questions about what types of events you want to use in your application. 
Logic is employed in the process that adheres to SDK or license restrictions (such as only 
being able to specify one menu structure per application). We even included a GUID 
generator for your subscription ID.
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Deprecated Features or Features No Longer Supported

NA

Do You Integrate With QBMS?

If your application integrates with the QuickBooks Merchant Service, be sure to take a look 
at some of the important changes in this area. Check the IDN website for more information 
about these changes.

Request/Field-Level Detail Of New and Changed Features

NOTE

None of the new or changed features listed below apply to 
QBOE unless explicitly stated.

The following table lists the changed behavior and/or fields for each SDK request:

Object Operation Changes

Account Add
Mod

TaxLineID added

AccountTaxLineInfo Query new request added

ARRefundCreditCard Add
Query

CreditCardTxnType added to CreditCardTxnInputInfo 
aggregate

Bill Add

BillMod

BillQuery

UnitOfMeasure added to ItemLineAdd and 
ItemGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineMod and ItemGroupLineMod 

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineRet and ItemGroupLineRet 

BuildAssembly Add
Mod

MarkPendingIfRequired boolean added

Charge Add

Mod

Query

UnitOfMeasure added

UnitOfMeasure and OverrideUOMSetRef added

UnitOfMeasure and OverrideUOMSetRef added to the 
Ret
Request/Field-Level Detail Of New and Changed Features 5
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Check Add

CheckMod

CheckQuery

ApplyCheckToTxnAdd added.
UnitOfMeasure field added to ItemLineAdd and 
ItemGroupLineAdd

ApplyCheckToTxnMod added.
UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineMod and ItemGroupLineMod

IncludeLinkedTxns added to the request. LinkToTxn 
added to the CheckRet

Company Query SubscribedServices added to the CompanyRet

CreditCardCharge Add

Mod

Query

UnitOfMeasure added to ItemLineAdd and 
ItemGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineMod and ItemGroupLineMod

UnitOfMeasure, OverrideUOMSetRef, and 
CreditCardTxnInfo added to ItemLineRet and 
ItemGroupLineRet

CreditCardCredit Add

Mod

Query

UnitOfMeasure added to ItemLineAdd and 
ItemGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineMod and ItemGroupLineMod

UnitOfMeasure, OverrideUOMSetRef, and 
CreditCardTxnInfo added to ItemLineRet and 
ItemGroupLineRet

CreditMemo Add

Mod

Query

UnitOfMeasure and CreditCardTxnInfo added to 
CreditMemoLineAdd and CreditMemoGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
CreditMemoLineMod and CreditMemoGroupLineMod

UnitOfMeasure, OverrideUOMSetRef, and 
CreditCardTxnInfo added to CreditMemoLineRet and 
CreditMemoGroupLineRet

Deposit Mod New request

Object Operation Changes
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Estimate Add

Mod

Query

ShipAddress added
UnitOfMeasure and PriceLevelRef added to 
EstimateLineAdd
UnitOfMeasure is added to EstimateGroupLineAdd

ShipAddress added
UnitOfMeasure, OverrideUOMSetRef, and 
PriceLevelRef added to EstimateLineMod. 
UnitOfMeasure and OverrideUOMSetRef added to 
EstimateGroupLineMod

UnitOfMeasure and OverrideUOMSetRef added to 
EstimateLineRet and EstimateGroupLineRet 

ShipAddress and ShipAddressBlock added to the Ret.

Invoice Add

Mod

Query

UnitOfMeasure added to InvoiceLineAdd and 
InvoiceGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
InvoiceLineMod and InvoiceGroupLineMod

UnitOfMeasure and OverrideUOMSetRef added to 
InvoiceLineRet and InvoiceGroupLineRet

ItemDiscount Mod AccountRef added
ApplyAccountRefToExistingTxns added

ItemGroup Add

Mod

Query

UnitOfMeasureSetRef added
UnitOfMeasure added to ItemGroupLine 

UnitOfMeasureSetRef added
ForceUOMChange added
UnitOfMeasure added to ItemGroupLine 

UnitOfMeasureSetRef added to Ret
UnitOfMeasure added to ItemGroupLineRet 

ItemInventory Add

Mod

Query

ManufacturerPartNumber added
UnitOfMeasureSetRef added

ManufacturerPartNumber added
UnitOfMeasureSetRef added
ForceUOMChange added
IncomeAccountRef added
ApplyIncomeAccountRefToExistingTxns added

ManufacturerPartNumber and UnitOfMeasureSetRef 
added to Ret

Object Operation Changes
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ItemInventoryAssembly Add

Mod

Query

UnitOfMeasureSetRef added

UnitOfMeasureSetRef added
ForceUOMChange added
IncomeAccountRef added
ApplyIncomeAccountRefToExistingTxns added

UnitOfMeasureSetRef added to Ret

ItemNonInventory Add

Mod

Query

ManufacturerPartNumber added
UnitOfMeasureSetRef added

ManufacturerPartNumber added
UnitOfMeasureSetRef added
ForceUOMChange added
In the SalesOrPurchaseMod agggregate

AccountRef added
ApplyAccountRefToExistingTxns added

In the SalesAndPurchaseMod aggregate
IncomeAccountRef added
ApplyIncomeAccountRefToExistingTxns added
ExpenseAccountRef added
ApplyExpenseAccountRefToExistingTxns added

ManufacturerPartNumber and UnitOfMeasureSetRef 
added to Ret

ItemOtherCharge Mod In the SalesOrPurchaseMod agggregate
AccountRef added
ApplyAccountRefToExistingTxns added

In the SalesAndPurchaseMod aggregate
IncomeAccountRef added
ApplyIncomeAccountRefToExistingTxns added
ExpenseAccountRef added
ApplyExpenseAccountRefToExistingTxns added

ItemReceiptAdd Add

Mod

Query

UnitOfMeasure added to ItemLineAdd and 
ItemGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineMod and ItemGroupLineMod

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineRet and ItemGroupLineRet

Object Operation Changes
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ItemServiceAdd/Query Add

Mod

Query

UnitOfMeasureSetRef added

UnitOfMeasureSetRef added
ForceUOMChange added
In the SalesOrPurchaseMod agggregate

AccountRef added
ApplyAccountRefToExistingTxns added

In the SalesAndPurchaseMod aggregate
IncomeAccountRef added
ApplyIncomeAccountRefToExistingTxns added
ExpenseAccountRef added
ApplyExpenseAccountRefToExistingTxns added

UnitOfMeasureSetRef added

ListDel UnitOfMeasureSet added to enum list of deletable 
objects.

ListMerge new request

PaymentMethod Add

Query

 PaymentMethodType enum is added. Available values 
are:

AmericanExpress
Cash
Check
DebitCard
Discover
ECheck
GiftCard
MasterCard
Other
OtherCreditCard
Visa 

PurchaseOrder Add

Mod

Query

UnitOfMeasure and ManufacturerPartNumber added 
to PurchaseOrderLineAdd
UnitOfMeasure added to PurchaseOrderLineGroupAdd

UnitOfMeasure, OverrideUOMSetRef, and 
ManufacturerPartNumber added to 
PurchaseOrderLineMod

UnitOfMeasure, OverrideUOMSetRef, and 
ManufacturerPartNumber added to 
PurchaseOrderLineGroupMod

UnitOfMeasure and OverrideUOMSetRef added to 
PurchaseOrderLineRet and 
PurchaseOrderLineGroupRet

Object Operation Changes
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Changes Impacting QBFC Integrations

If you recompile your application with QBFC7, you may need to change your code slightly 
if 

• You use any of these Add or Mod requests, due to the addition of the 
OverrideUOMSetRef to those requests.:
> Invoice
> Estimate

ReceivePayment Add

Mod

Query

CreditCardTxnType added to CreditCardTxnInfo

CreditCardTxnInfoMod added.

CreditCardTxnType added to CreditCardTxnInfo

SalesOrder Add

Mod

Query

UnitOfMeasure added to SalesOrderLineAdd and 
SalesOrderGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
SalesOrderLineMod and SalesOrderGroupLineMod

UnitOfMeasure and OverrideUOMSetRef added to 
SalesOrderLineRet and SalesOrderGroupLineRet

SalesReceipt Add

Mod

Query

UnitOfMeasure and CreditCardTxnInfo added to 
SalesReceiptLineAdd
UnitOfMeasure added to SalesReceiptGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
SalesReceiptLineMod
and SalesReceiptGroupLineMod

UnitOfMeasure, OverrideUOMSetRef, and 
CreditCardTxnInfo added to SalesReceiptLineRet and 
SalesReceiptGroupLineRet

UnitOfMeasureSet Add
Query

New requests

VendorCredit Add

Query

UnitOfMeasure added to ItemLineAdd and 
ItemGroupLineAdd

UnitOfMeasure and OverrideUOMSetRef added to 
ItemLineRet and ItemGroupLineRet

WorkersCompCode Add

Mod

Query

New requests 

Object Operation Changes
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> SalesOrder
> SalesReceipt
> CreditMemo
> Estimates (for changes in the Ret) 

• You use PayPeriod in either EmployeePayrollInfo or EmployeePayrollInfoMod due to 
the new OR with PayPeriod and PayrollScheduleRef

Bugs Fixed in This Release
The following table lists the bug fixes by the SDK request.

SDK Request Bug and nature of Fix

BillMod QuickBooks business logic does not allow an Accounts Payable 
account to be specified as the account in ExpenseLine. Yet, when 
that account type was used in an ExpenseLine in a BillMod 
request in QuickBooks 2007, a misleading error message was 
returned: “Object with the ListID not found”.

This has been changed so that the proper error message is 
returned indicating that the wrong account type is being used.

BillPaymentCheckAdd If the CheckNumber field is supplied with data, and 
IsToBePrinted were set to True, the CheckNumber was cleared 
during the Add and didn’t appear in QuickBooks. 

The fix is to automatically and internally set IsToBePrinted to 
False if the CheckNumber is supplied.

ChargeAdd When a statement charge was added with no due date supplied, 
the Charge was created with a due date anyway.

This has been fixed: If no due date is specified in the Add 
request, the Charge is created with no due date, just as you can 
do in the QuickBooks UI.

CheckMod QuickBooks business logic does not allow an Accounts Payable 
account to be specified as the account in ExpenseLine. Yet, when 
that account type was used in an ExpenseLine in a CheckMod 
request in QuickBooks 2007, a misleading error message was 
returned: “Object with the ListID not found”.

This has been changed so that the proper error message is 
returned indicating that the wrong account type is being used.

DataExtDefName For custom field definitions, if an ampersand was used in the 
name, the ampersand did not display in QuickBooks and the 
letter after the ampersand was underlined.

The ampersand character now displays properly.

EmployeeQuery The billing rate level for the employee was not returned.

Billing rate level now returned.

GeneralDetailReportQuery The response xml for GeneralDetailReportQuery using qbxml 4.0 
should not include <ColType>LatestOrPriorState</ColType> but 
it does. 

No longer returns that column type.
Bugs Fixed in This Release 11
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Known Bugs and Workarounds
The following table documents known behavior quirks as well as known issues and any 
workarounds for them.

InvoiceAdd In previous releases, if the InvoiceAdd request contained a 
ClassRef, that ClassRef was applied automatically to all the line 
items and you could not clear it. 

Now, you can clear the ClassRef to empty for a given line item 
simply by specifying an empty ClassRef for the line, like this: 
<ClassRef> </ClassRef>.

TimeTrackingAdd TimeTrackingAdd ignores the seconds if the Duration value 
contains them.

In the QuickBooks UI, if the user enters time value with 
seconds, those are rounded to the nearest 30 second value. The 
TimeTrackingAdd request has been fixed to behave in the same 
way if Duration contains seconds.

TimeTrackingAdd
Adding a new time tracking record for an employee that has a 
default workers comp code should cause that code to be used 
and show up in QuickBooks. However, the workers comp code 
was being left blank after the Add.

The workers comp code now shows up as expected in 
QuickBooks after the Add.

TxnDisplayMod 
In certain instances, such as the payment having cleared, for 
the TxnDisplayModTypes BillPaymentCheck and 
BillPaymentCreditCard, you get a StatusCode error of 3300, 
"Could not open the requested BillPaymentCheck [or 
BillPaymentCreditCard] form or window." 

The form for the transaction is now displayed.

Issue Workaound

In the sample 
\samples\qbdt\cpp\qbxml\hostquery, you may get 
a build failure when you try to build the sample, 
due to a problem with the Interop.QbxmlRP2 
reference.

If you get this error, simply go to the project 
properties, click on the .Net tab and remove the 
reference to Interop.QBXMLRP2. Re-add the 
reference to it and rebuild the hostquery sample. It 
should build properly.

If you use qbXML rather than QBFC, notice that 
the new 7.0 request AccountTaxLineInfoQuery 
does not work if issued in the following XML 
format:

<AccountTaxLineInfoQueryRq> 
</AccountTaxLineInfoQueryRq>

Use this format instead:

<AccountTaxLineInfoQueryRq />

QBFC7 does use the above format, so you won’t need 
to worry about this issue if you use QBFC.

In the SDK 7.0 beta, CheckRet did not show the 
LinkToTxn aggregate, which is returned as part of 
the support for linking checks to certain 
transactions. 

This has been fixed in the final 7.0 qbXML spec, but 
notice that this whole feature won’t be implemented 
fully until the R3 patch to QB2008.

SDK Request Bug and nature of Fix
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A CustomerQuery may contain different results 
(sort order) when run against QB 2008 and 
greater than the same query running against QB 
2007 and earlier. This difference in sort order may 
be observed if you use MaxReturned set to a 
numeric value or if the query response contains 
the ampersand character & or apostrophe ‘ in the 
<name> field.

In the Microsoft Vista OS, the path c:\documents 
and settings\all users\ used in Windows XP is 
translated to the path c:\users\public\. If  a 
company file in QuickBooks is opened on Vista 
with the path "c:\documents and settings\all 
users..." and that filename is also specified with 
the same path in an SDK integrated application, 
the SDK response says that QuickBooks is already 
open with a different file. As per the following: "-
2147220470  A QuickBooks company data file is 
already open and it is different from the one 
requested."

Developers may be accustomed to using the 
common file open dialog to allow the user to 
browse to a file (for example, the select a 
company file dialog in SDKTestPlus3.exe) 

Unfortunately, Microsoft changed the behavior of 
this dialog in Vista so it actually attempts to OPEN 
the file before returning control to the app that 
called it. 

The result is that if QB has the file open (or, more 
accurately, the QB database server has the file 
open) you get an error from the dialog that the file 
is locked and you cannot use it. 

Here is how to handle this:

1. In the application’s first connection do a 
BeginSession and invoke GetCurrentFilename and 
save it away for future use, or display to the user, or 
whatever.

2. In all subsequent connections invoke BeginSession 
using that stored company file name.
If the application gets an error that it cannot open 
the file, invoke BeginSession again, invoke 
GetCurrentFilename, compare against the stored file 
name and ask user about it if they don’t match.

During installation of QB SDK on a system without 
QuickBooks installed you may encounter this error 
during the execution of dotnetfxSp1.exe:

“The upgrade patch cannot be installed by the 
Windows Installer service because the program to 
be upgraded may be missing, or the upgrade patch 
may update a different version of the program. 
Verify that the program to be upgraded exists on 
your computer and that you have the correct 
upgrade patch.” 

To solve this, install .NET from the Microsoft web site 
and retry the installation.

During SDK installation, you may see a message 
informing you that the UI and eBay sample could 
not be installed. 

You can safely ignore and dismiss this message as it 
has no effect and the installation will proceed 
successfully.

In a VehicleMileageQuery, if you specify time 
values (for example, 2002-06-05T10:21:10) in 
any of the date range filters, you get a status code 
error 3020 statusSeverity="Error" 
statusMessage="There was an error when 
converting the date value...” 

The reason for this is that Vehicle Mileage supports 
only Date values, not DateTime values, despite what 
the OSR says. The workaround is to use only date 
values, as follows: 2002-06-05. 

Issue Workaound
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What’s New in QBWC Web Connector 2.0
The following improvements have been made to QBWC 2.0:

If you use DeliveryPolicy in both a 
DataEventSubscription and a UIEventSubscription, 
you could set one to DeliverAlways and the other 
to DeliverOnlyIfRunning. In that case, QB will 
cache your application’s COM pointer if the first 
event for this application in a company file session 
is associated with the DeliverAlways policy. 

If a user installs a copy of Convertible QuickBooks 
2006 or greater but does not select one of the 
available editions (Premier, Accountant, Contractor 
edition, etc), and an SDK application is 
subsequently started, QuickBooks will prompt the 
user to select an edition. The application’s call to 
BeginSession will fail while QuickBooks is being 
configured for the selected edition. 

The workaround is to have the user finish the process 
of selecting the desired edition and then restart the 
SDK application.

QuickBooks Canada does not currently return 
values stored in the Company Data Extension 
fields.  The bug affects QuickBooks Canada 
versions 2004 through 2007 and may affect 
QuickBooks UK versions 2004 through 2006.

The order of some columns in reports may be 
different in QuickBooks 2008 than they were for 
older versions of QuickBooks. 

This is not a bug, just a heads-up: the SDK 
documentation has always warned about assuming 
any column order.

QuickBooks caches the latest Refnumber for each 
transaction type. If you try to save a transaction 
using the default Refnumber from the UI, the UI 
will warn you if someone else already saved 
transaction with the same refnumber and give you 
the opportunity to change it to the new latest 
Refnumber. In the SDK, it simply gets used and 
you wind up with two transactions with the same 
refnumber

In QuickBooks Simple Start edition, it is possible 
for an SDK application to create a subitem for a 
given item. It is not possible to do this in the UI, 
because the UI for creating items does not allow a 
subitem to be specified. You should avoid doing 
this in your application when running against 
Simple Start.

If QuickBooks Verify is running and an SDK 
application issues a request, the request will not 
complete until the verify finishes.

If QuickBooks 2007 and later is running non 
hosted, SDK applications starting QuickBooks in 
DoNotCare mode will open QuickBooks in single-
user mode.

Issue Workaound
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• Support for interactive mode:
> Protocol Handler for Internet Explorer that allows web-based applications to 

interact directly with the web connector.
> Three new optional web methods to facilitate Interactive mode:

-InteractiveURL
-InteractiveRejected
-isInteractiveDone

• Masterkeys are now handled and maintained automatically by .NET managed password 
storage mechanism.

• Update locking mechanism to help manage company file during simultaneous updates 
from multiple web connector clients.

• Included VERBOSE mode for logging level. With this, we now have three log levels: 
NONE = No logging, DEBUG (default setting) = Logging + first 50 characters of 
request/response xml, VERBOSE = Logging + complete request/response xml 

• Added a response value of an O: (stands for Okay) 
O:<QBWC_Version_Supported_By_Server> for clientVersion(). It provides an update 
path for user if server’s QBWCVersion is greater than user’s QBWCVersion

• NoOp for sendRequestXML(). When sendRequestXML() call receives an empty string, 
QBWC calls getLastError(). If a NOOP is sent back from web-service for the 
getLastError(), QBWC will pause update for 5 seconds. This allows a web-service to 
tell QBWC to wait five seconds before calling sendRequestXML() again. 

• New webmethod getServerVersion() provides a way for web-service to notify QBWC 
of itís version. This version string shows up in the More Information pop-up dialog in 
QBWC. 

• Notification (system tray pop up) is now turned off by default.
• A new optional QWC parameter <CertURL> to provide means to provide certificate 

server for ssl certificates other than web server.
• A new optional QWC parameter <Notify> introduced. Value of true will enable 

notification (pop up at systray) at app level. Anything else will disable notification.
• - A new optional QWC parameter <AppDisplayName> is introduced. If available, 

QBWC will use this to display name in the QBWC UI. Otherwise, use <AppName> as 
usual. This is just for UI purpose. Update process still uses the <AppName> (or, 
AppUniqueName if provided)

• A new optional parameter <AppUniqueName> is introduced. If this element is 
available in QWC file, QBWC will not go into itís typical clone/replace mode for 
AppName and directly use the replace routine.

• There are new optional QWC file parameters for three rp.AuthPreferences parameters 
IsReadOnly (true/false), UnattendedModePref (umpRequired/umpOptional), and 
PersonalDataPref(pdpNotNeeded/pdpOptional/pdpRequired).

• Improved performance due to code refactoring.
• Improved error messages with suggestions on actions where applicable.
What’s New in QBWC Web Connector 2.0 15
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New or Modified Files of Interest

This release includes documentation, tools, and samples. The following files and directories 
may be of particular interest to you:

• This release includes .NET Primary Interop Assemblies (PIAs) for QBXMLRP2, 
QBFC7, QBFC6, QBFC5, QBFC4, QBFC3, and QBFC2.1. These assemblies are 
included in the redistributable installers and merge modules for each library. If you 
have previously built a local interop assembly for use with your .NET integrations, 
please be sure to update them to use the primary interop assemblies included with this 
release instead.

• doc\qbxmlops70.xml and doc\qbxmlso70.xml
The sample files containing all qbXML requests/responses, and their SignonMsgs 
requests and responses.

• OSR\OnscreenRef
The Onscreen Reference for the SDK. 

All samples require the QBXMLRP2 Request Processor, QuickBooks, and the QuickBooks 
sample product-based company file. Samples new in this release may require the latest 
QuickBooks version (currently QuickBooks 2008). The QBXMLRP2 Request Processor is 
installed automatically by QuickBooks 2008. The SDK also installs the request processor.

Installation Instructions

IMPORTANT

During SDK installation, if the eBay SDK has previously been 
installed on your system, the SDK installer may report a 
failure registering ebay.SDK.tlb. This error can safely be 
ignored and the installation will proceed normally.

To install the SDK using the installer, execute QBSDK70.exe. The installer also adds a 
menu (Start>Programs>QuickBooks SDK 7.0>) that provides convenient access to SDK 
tools, samples, and documentation (including the Onscreen Reference). You can also access 
the qbXML Validator and qbXML Test applications through the "Send To" context menu 
for files.

Installing on a System that Doesn’t Have QuickBooks

During installation of QB SDK on a system without QuickBooks installed you may 
encounter this error during the execution of dotnetfxSp1.exe:

“The upgrade patch cannot be installed by the Windows Installer service because the 
program to be upgraded may be missing, or the upgrade patch may update a different 
version of the program. Verify that the program to be upgraded exists on your computer and 
that you have the correct upgrade patch.” 
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To solve this, install .NET from the Microsoft web site and retry the installation.

Registering an Application for QuickBooks Online Edition

Before an application can connect with QuickBooks Online Edition using the SDK, it must 
be registered with the Intuit Developer Network. To register your application and obtain an 
application ID, please follow the instructions in the QuickBooks SDK Programmer’s Guide 
and visit http://appreg.intuit.com to register your application.

Importing the Correct Library

For Visual C++ applications (if you are not using the QBFC Library), you need to import 
the library named qbxmlrp2.dll, which is installed in C:\Program Files\Common 
Files\Intuit\QuickBooks. For Visual Basic applications, select Project > References from 
within your VB project. Find “QBXMLRP2 1.0 Type Library” in the list and check the box 
next to it, then click OK. If you don’t find the entry in the list, you can browse to it.

About Redistributing QBXMLRP2
Previous to SDK 7.0, we recommended redistributing QBXMLRP2. Beginning with SDK 
7.0, we recommend that you do NOT redistribute QBXMLRP2 except in the following two 
cases:

• Your application needs to support QuickBooks versions older than QB 2004.
• Your application runs against versions of QuickBooks older than QB 2005 but needs 

certain advanced features of the request processor, such as AuthFlags.

If either of these apply to your case, you can redistribute QBXMLRP2 by manually 
including the merge module QBXMLRP2.msm or QBXMLRP2PIA.msm (for .Net 
applications)

Creating Applications that Can Run on 64-Bit Operating Systems

If you want your SDK application to run on a 64-bit machine, and are using Visual Studio 
to develop it, you must have the compiler options set properly. In particular, you must set 
the Platform Target to x86. 

This has caused some developers problems, because the default setting if you simply create 
a new project is “Any CPU”, which is a setting that has prevented some developer 
applications from running on 64-bit OS. 

Documentation
A new and improved unified OSR is available: you’ll want to check this out. 
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This release updates the QuickBooks Web Connector Programmer’s Guide, which 
describes how to develop web services that work with the QuickBooks web connector. The 
other documents are updated versions of previous documents: t the QB SDK Programmer’s 
Guide is a comprehensive treatment of QB SDK programming, and the Technical Overview 
provides a high level overview of the functionality provided in SDK. All documents are 
available in both PDF and HTML. Along with the other major features in the SDK, the 
manuals and the Onscreen Reference can be conveniently accessed through the Start menu.

The QBMS documentation has been removed because it is now installed in the separate 
QBMS SDK.

Tools
A new and improved unified OSR is available: you’ll want to check this out. 

The qbXML Validator tool contains new functionality that allows you to verify qbXML 
requests that correspond to these combinations:

• qbXML 7., 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 for U.S. editions of QuickBooks
• qbXML 7.0, 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, and 2.0 for QuickBooks Online Edition
• qbmsXML 1.0 for QuickBooks Merchant Service
• qbXML CA3.0 and CA2.0 for Canadian editions of QuickBooks
• - qbXML UK3.0 and UK2.0 for UK editions of QuickBooks

The Validator is installed automatically as part of the SDK installation.  

The file tools\SDKTest\SDKTestPlus3.exe is an enhanced version of SDKTest that uses 
QBXMLRP2 and allows the user to control every aspect of the connection to QuickBooks 
and can be used to send XML request files to QuickBooks. It supports sending subscription 
request XML as well as data integration XML. The source code for this tool is in 
samples\qbdt\vb\qbxml\SDKTestPlus3.

The file tools\SubscriptionManager\SubView.exe is a tool for viewing and removing 
application subscriptions from QuickBooks.

Samples

The Samples directory contains a readme.html (which can be accessed from Start > 
Programs > QuickBooks SDK X.0 > Samples). This file lists each sample and provides 
links to open the project directory, the project itself, and the executable form of the 
application.

The SDK installer verifies that the MSXML4.0SP2 or greater API from Microsoft is 
installed on your system. If MSXML is not present, the SDK installer will install it for you. 
This API is used by the SDK’s Validator tool and several samples. 

Some samples require .NET 2.0. This can be downloaded from the Microsoft website.
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Downloading MSXML 6.0

If you want to run the sample applications on a system that does not have MSXML 
installed (for example, if you want to use Remote Data Sharing from a system that does not 
have the SDK installed), you will need to install MSXML. In addition, if your application is 
dependent on MSXML Core Services, you will need to redistribute that software in your 
installer. The MSXML Core Services software is available from Microsoft

Building the C++ Samples

The #import “qbxmlrp2.dll” statement in the C++ samples allows these applications to use 
the COM interface supported by the QuickBooks SDK. This statement will cause an error 
when you are building the samples in Microsoft Visual Studio if the Include path is not set 
to include the location of this DLL. The DLL is installed with QuickBooks and resides in 
the QuickBooks common directory, currently defined as 
C:\Program Files\Common Files\Intuit\QuickBooks. Add this directory to the Include path 
by choosing the Tools menu, Options command, and the Directories tab in Visual Studio.

UIandEventTest Samples

In order to build the EventHandler C++ sample, you will need to specify the QuickBooks 
executable path for the sample project. The method for doing this is different for Visual 
Studio 6.0 and Visual Studio .NET. 

For Visual Studio 6.0, select "Options" from the "Tools" menu. Select the "Directories" tab 
and then select "Executable Files". Add the QuickBooks executable path to the list of 
directories here.

For Visual Studio .NET, select "Properties" from the "Project" menu. Under the "C/C++" 
options, select "General" and add the QuickBooks executable path to the "Additional 
Include Directories". Under the "MIDL" options, also select "General" and add the QB path 
to "Additional Include Directories".

All of these C++ samples also use QBXMLRP2.DLL in the QuickBooks "common" 
directory. The project files currently specify this path as C:\Program Files\Common 
Files\Intuit\QuickBooks. If this path is different on your machine, you will need to change it 
in the project files.

Known Problems in VB Sample Applications

The Visual Basic sample applications allow you to view a response from QuickBooks. If 
you try to view a response that is greater than 32K, you will receive an “Out of memory” 
error.  This happens because the VB sample applications use a TextBox control, which has 
a 32K limit, rather than a RichTextBox control. In a Windows 98 or Windows Me 
environment, this can corrupt memory, and the application might not terminate properly.
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There is a known issue (not related to qbXML) with the AddReceivePayment sample 
application. The MS Visual Studio application must be installed before you can run 
AddReceivePayment, or you will receive the following error message when you run the 
application: “Class not registered. You need the following file to be installed on your 
machine. MSSTDFMT.DLL.”

Using Payroll Reports

If your application is accessing a company file that is currently signed up for a subscription 
to a payroll service, you can generate payroll reports and query PayrollNonWageItems.

To test this feature, you can use one of Intuit’s sample company files (even though it will 
not be signed up for a subscription to a payroll service). Please be aware that QuickBooks 
will record an artificial creation date to any test data that you add to a sample company file.

Deprecation Policy
You may notice that some items in the OSR are marked as deprecated. Deprecated items 
supported for the release in which they are deprecated, in the next major release they will 
be removed from the spec and their functionality will not be available.

System Requirements
The system requirements for the QuickBooks SDK are the same as those for the version of 
QuickBooks that is running. QuickBooks 2008 and 2007 will run on Microsoft Windows 
2000, Windows XP, and Windows Vista. 

QuickBooks 2006 will run on Windows 2000 and Windows XP.

QuickBooks 2005 and 2004 will run on Microsoft Windows 98, 2000, Me, or XP operating 
systems. 

QuickBooks 2002 and 2003 will run on Windows NT, 98, 2000, Me, or XP operating 
systems.(The SDK does not run in unattended mode—that is, with automatic login—on 
Windows 98, First Edition; it does run in unattended mode on Windows 98 Second Edition 
on QuickBooks 2005 and earlier.)

QuickBooks Products and qbXML/QBFC Support
The following table of QuickBooks versions and supported qbXML and QBFC versions 
takes precedence over any other such tables in QB SDK documentation.
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The following table lists the different versions of QuickBooks and the corresponding 
versions of the qbXML specifications that support them. Note: QuickBooks Mac, 
QuickBooks Basic, UK Simple Start edition, UK regular editions, and the Canadian 
QuickBooks Easy Start Edition do not support the SDK. (For UK, use QuickBooks Pro and 
QuickBooks Accountant.)

The following table lists the different versions of the QuickBooks Foundation Class 
(QBFC) Library and the versions of the qbXML specification that support them.

Version of QuickBooks
qbXML Specification 
Version

QuickBooks 2008 and Enterprise 8.0 (Using 
QBXMLRP2)

7.0, 6.0, 5.0, 4.1 4.0, 3.0, 
2.1, 2.0, 1.1, 1.0

QuickBooks 2007 and Enterprise 7.0 (Using 
QBXMLRP2) 

6.0, 5.0, 4.1 4.0, 3.0, 2.1, 
2.0, 1.1, 1.0 

QuickBooks 2006 and Enterprise 6.0 (Using 
QBXMLRP2) 

5.0, 4.1 4.0, 3.0, 2.1, 2.0, 
1.1, 1.0 

QuickBooks 2005 and Enterprise 5.0 (R5 and later)
(using QBXMLRP2) 

4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 
1.0 

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP2) 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP2) 

3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2003, Enterprise 3.0* (R7 and above)
and all later versions of QuickBooks using QBXMLRP

2.1, 2.0, 1.1, 1.0

QuickBooks 2003
(and Enterprise 2.0)*

2.0, 1.1, 1.0

QuickBooks 2002 (R2 and above)
(and Enterprise)*

1.1, 1.0 

QuickBooks 2002 (R1)* 1.0

QuickBooks Online Edition 7.0, 6.0, 5.0, 4.1, 4.0, 3.0, 
2.1, 2.0

QuickBooks 2004-2007 Canadian
(using QBXMLRP2)

 CA3.0, CA2.0

QuickBooks 2004-2006 UK Editions
(using QBXMLRP2) 

UK3.0, UK2.0

QuickBooks 2003, Canadian and UK Editions, CA2.0. 
UK2.0)* and all later versions of these through Quick-
Books 2006

CA2.0. UK2.0

*Earlier releases of QuickBooks will work with either version of the Request Processor (QBXMLRP2 or 
QBXMLRP). We recommend you upgrade existing applications to use QBXMLRP2. SDK 3.0 and greater features are 
available only with QBXMLRP2; in addition, this Request Processor solves some problems found in the older Request 
Processor.
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If You Have Questions . . .
For IDN support, please visit http://developer.intuit.com/support.

For community support, visit http://idnforums.intuit.com.

QBFC Library qbXML Specification 
Version

QBFC7
(including support for QuickBooks Online Edition) 

7.0, 6.0, 5.0, 4.1, 4.0, 
3.0, 2.1, 2.0, 1.1, 1.0

Does NOT support:

CA3.0, CA2.0, UK3.0, 
UK2.0

QBFC6
(including support for QuickBooks Online Edition) 

6.0, 5.0, 4.1, 4.0, 3.0, 
2.1, 2.0, 1.1, 1.0

Does NOT support:

CA3.0, CA2.0, UK3.0, 
UK2.0

QBFC5
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

5.0, 4.1, 4.0, 3.0, 2.1, 
2.0, 1.1, 1.0, CA3.0, 
CA2.0, UK3.0, UK2.0

QBFC4
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

4.0, 3.0, 2.1, 2.0, 1.1, 
1.0, CA3.0, CA2.0

QBFC3
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

3.0, 2.1, 2.0, 1.1, 1.0

QBFC2_1
   (including support for QuickBooks Online Edition)

2.1, 2.0, 1.1, 1.0

QBFC2 2.0, 1.1, 1.0

QBFC2CA CA2.0

QBFC 1.1, 1.0
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